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This protocol describes rapid colorimetric detection of Escherichia coli, Salmonella spp., and Listeria monocytogenes from large volumes (10

L) of agricultural waters. Here, water is filtered through sterile Modified Moore Swabs (MMS), which consist of a simple gauze filter enclosed

in a plastic cartridge, to concentrate bacteria. Following filtration, non-selective or selective enrichments for the target bacteria are performed

in the MMS. For colorimetric detection of the target bacteria, the enrichments are then assayed using paper-based analytical devices (UPADs)
embedded with bacteria-indicative substrates. Each substrate reacts with target-indicative bacterial enzymes, generating colored products that
can be detected visually (qualitative detection) on the pPAD. Alternatively, digital images of the reacted yPADs can be generated with common
scanning or photographic devices and analyzed using ImageJ software, allowing for more objective and standardized interpretation of results.
Although the biochemical screening procedures are designed to identify the aforementioned bacterial pathogens, in some cases enzymes
produced by background microbiota or the degradation of the colorimetric substrates may produce a false positive. Therefore, confirmation using
a more discriminatory diagnostic is needed. Nonetheless, this bacterial concentration and detection platform is inexpensive, sensitive (0.1 CFU/
ml detection limit), easy to perform, and rapid (concentration, enrichment, and detection are performed within approximately 24 hr), justifying its
use as an initial screening method for the microbiological quality of agricultural water.

Video Link

The video component of this article can be found at https://www.jove.com/video/51414/

Introduction

It is important that foodborne disease agents are detected rapidly and preferably in field-based settings in order to reduce the burden of
foodborne disease. Common strategies to detect foodborne bacterial pathogens include biochemical profiling, selective and differential culturing,
immunological isolation and detection, and molecular detection. However, these methods are hampered by sporadic contamination, small
sample sizes tested, the often low concentrations of the foodborne pathogenic bacteria, require long processing times, and/or are not applicable
for field settings. Further, compounds in many food matrices are inhibitory to detection and diagnostic applications. In order to improve the
likelihood of microbial detection, the United States Food and Drug Administration has suggested that testing agricultural water (such as

wash water and irrigation water) which either comes in contact with a large surface area of fresh produce or serves as a vehicle for produce
contamination is a viable alternative to direct testing of food". Even so, the often low natural pathogen-burden coupled with the dilution effect of
the representative agricultural water sample makes sample preparation methods for pathogen concentration essential. Such a method would
require sampling large volumes of water (210 L), adequate pathogen-concentration, and compatibility with downstream detection strategies.

Modified Moore swabs (MMS) are inexpensive, simple, and rugged devices used for concentrating bacteria from large volumes (=10 L) of
water’®. The MMS consists of a plastic cassette filled with gauze, which serves as a coarse filter for large volumes of water pumped through
the cassette using a peristaltic pump. The MMS is a non-discriminatory method of bacterial concentration (=10 fold concentration) that captures
organic and inorganic particulate material including microorganisms in processed liquid samples. It is likely that the excellent efficacy of
concentration of target microorganisms by the MMS can be explained by the fact that microorganisms are expected to be attached to the silt-
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clay fraction or organic micro-aggregates of the suspended solids®. The rugged design of the MMS allows for overcoming most shortcomings
associated with other filtration methods for capture and concentration of bacteria from water, such as clogging of filters, inability to process large
volumes, filter samples with high turbidity, and high costs. For these reasons, the FDA is recommending that MMS’s be incorporated into official
procedures for environmental and produce-related sample collection procedures

Here, a method is described for the concentration, enrichment, and detection of Escherichia coli, Salmonella spp., and Listeria monocytogenes
from agricultural waters. A MMS is used for concentration of bacteria, and also serves as a vessel for selectlve or non-selective bacterial
enrichment. Bacterial detection is achieved biochemically using paper-based analytical devices (uPADs) UPADs can be manufactured as
fluidic networks or spot tests using a variety of methods including photolithography, inkjet printing, stamping, and wax prlntlng Examples

of fluidic designs can be dendritic channel patterns where the sample is deposited in the center and subsequently flows to distal reservoirs or
single channel patterns in which the sample or substrate are pulled from the outer reservoirs of the channel by capillary action into the center'
For this protocol, we have chosen to employ for 7-mm-diameter wax-paper spot arrays imbedded with chromogenic substrates that can be
processed by enzymes indicative of the microorganisms tested here: Chlorophenol red (3-D-galactopyranoside (CPRG) and 5-bromo-4-chloro-3-
indolyl B-D-glucuronide (X-Gluc) for detection of B-galactosidase and 3-glucuronidase produced by E. coli; 5-bromo-6-chloro-3-indolyl caprylate
(magenta caprylate) for the detection of C8-esterase produced by Salmonella spp.; and 5-bromo-4-chloro-3- mdonI myo-inositol phosphate (X-
InP) for detection of phosphatidylinositol-specific phospholipase C (PI-PLC) produced by L. monocytogenes Thus, the presence of a particular
bacterium can be observed visually without the need for complex equipment or data mterpretatlon The specificity and sensitivity of the enzyme-
based colorimetric yPAD detection of these specific target bacteria has been previously explored In addition, the sensitivity of the integrated
concentration-detection method for these target bacterla was evaluated by spiking of large volumes of water with pre-determined levels of
microorganisms (unpublished data and Bisha et al’ )

1. Concentration of Bacteria from Large Volumes of Agricultural Water Using MMS

1. MMS Preparation

1. Cut a rectangular section of 4-ply cheesecloth measuring 40 x 12 cm.

2. Fold the cheesecloth along both axes to obtain a rectangle of 20 x 6 cm.

3. Roll the cheesecloth tightly along its long axis to form a cylindrical swab of approximately 6 cm tall and 3 cm in diameter.

4. Autoclave the cheesecloth swab in aluminum foil, do not autoclave the cassette. Decontaminate the cassette by soaking it for 30 min
in 10% household bleach, and deactivate the residual chlorine by soaking the cassette for 15 min in a sodium thiosulfate pentahydrate
(Na,S,035-5H,0) solution (50 mg/L prepared in sterile water).

5. Insert the swab into the MMS cassette.

NOTE: If the non-disposable version of the MMS cassette is used, start with a 4-ply sheet of cheesecloth measuring 80 x 22 cm, fold it
to 40 x 11 cm and roll it to form a cylinder approximately 11 cm tall and 6 cm in diameter.

6. Assemble the MMS.

7. Attach vinyl tubing to spigots on both sides of the MMS, ensuring the tubing fully adheres to the spigots, and fix tubing into the
peristaltic pump. Ensure that the tubing upstream of the peristaltic pump is of sufficient length for sampling.

2. Concentration of Bacteria

1. Sample at least 10 L of agricultural water by running the peristaltic pump at high speed.

2. Atfter sampling is complete, withdraw the peristaltic pump inlet from the water sample and continue running the pump until no effluent
water is observed exiting the MMS.

3. If a manifold is used to run several samples at the same time, collect the effluent of each MMS, and when 10 L is filtered through a
single MMS close the valve for that particular MMS and continue running the pump.

1. When sampling is completed, withdraw the peristaltic pump inlet from the agricultural water, open all the valves of the manifold,
and continue running the pump until no effluent water is observed exiting the MMSs.

3. When concentration has been completed for all MMSs, carefully remove the vinyl tubing from the MMS spigots and cap the spigots on both
sides of the MMS. Tightly capped MMS can be stored for up to 12 hr before adding enrichment media.

2. MMS Enrichment and Sample Preparation

1. Enrichment
1. Unscrew the lid of the MMS, and aseptically add 20 ml of the appropriate sterile enrichment broth. Use one MMS for each selective
enrichment. Alternatively, perform a non-selective enrichment to propagate all three target bacteria in the same sample.
NOTE: If the non-disposable version of the MMS cassette is used, aseptically remove cheesecloth filter from the cassette and place in
a sterile bag before adding 225 ml of the appropriate enrichment media.
1. For enrichment of E. coli, add 20 ml of buffered peptone water (BPW) supplemented with 8 mg/L of vancomycin hydrochloride.
2. For enrichment of Salmonella spp., add 20 ml of BPW supplemented with the Salmonella supplement (4 ml/L).
3. For enrichment of L. monocytogenes, add 20 ml of VIDAS UP Listeria (LPT) broth.
4. For simultaneous non-selective enrichment for all three microorganisms using a single MMS, use universal preenrichment broth
(UPB).

2. Screw the lid of the MMS back on tightly. Ensure that the spigots are tightly capped to avoid spills and possible contamination during
enrichment.

Copyright © 2014 Journal of Visualized Experiments June 2014 | 88 | e51414 | Page 2 of 7


https://www.jove.com
https://www.jove.com
https://www.jove.com

L]
lee Journal of Visualized Experiments www.jove.com

3. Incubate the MMS for up to 18-24 hr in a shaking incubator at 200 rpm. Use 42 °C for E. coli and Salmonella spp. selective
enrichments. Use 30 °C for L. monocytogenes selective enrichment, and use 37 °C for non-selective enrichment.

2. Sample Preparation
1. When incubation has completed, remove the MMS from the incubator, uncap one of the spigots, and gently dispense about 0.5 ml into
a 1.5 ml microcentrifuge tube. Alternatively, unscrew the MMS and pipette out 0.5 ml of overnight enrichment.
NOTE: If the not-disposable version of the MMS cassette is used, pipette 0.5 ml of enrichment from the bag.
2. For colorimetric analysis of E. coli selective enrichment, or for the analysis of the non-selective enrichments, sonicate 0.5 ml of
enrichment at 5 W, 22 kHz for 20 sec using a probe sonicator.

3. Preparation and Embedding of Colorimetric Substrates in yPADs

1. Prepare enough yPADs for each sample and target tested. To detect E. coli prepare CPRG and X-Gluc pPADs, for Salmonella spp. detection
prepare MC puPADs, and for L. monocytogenes detection prepare X-InP pPADs.
1. Prepare HEPES buffer [0.1 M HEPES with 0.1% Bovine Serum Albumin (BSA)] for the colorimetric substrates and adjust the pH of the
buffer according to the substrate that is going to be used: pH 7.5 for preparation of CPRG or X-Gluc, pH 9 for MC, and pH 7 for X-InP.
2. Prepare stock solutions of the substrates in the pH adjusted HEPES buffer at concentrations of 3 mM (CPRG), 62.5 mM (X-Gluc), 15
mM (MC), 100 mM (X-InP). Protect the stock solutions from light.
3. Place the yPADs inside a sterile Petri dish, then imbed the yPAD microspot with 24 ul of each substrate stock solution.

4. Detection and Data Analysis

1. Detection
1. Add 6 pl of the enriched sample to each appropriate yPAD microspot contained in a Petri dish.
2. Place the cover back on the Petri dish and seal it with Parafilm.
3. Incubate the sample with the yPAD at 37 °C for up to 3 hr to allow for color development and drying of the microspots.

2. Visual Examination of the Results

1. Perform detection by simple visual inspection of the color changes of the uPADs.
NOTE: Typically, strong reactions that produce definitive color changes are expected following 18-24 hr of enrichment, which should
obviate the need for further clarification and should be considered positive.

2. Determine the presence of an E. coli positive sample by observing microspots imbedded with CPRG change from yellow to red-violet
and microspots imbedded with X-Gluc change from colorless to blue-green.

3. Determine the presence of a L. monocytogenes positive sample by observing microspots imbedded with X-InP change from colorless
to indigo.

4. Determine the presence of a Salmonella spp. positive sample by observing microspots imbedded with MC change from colorless to
purple-mauve.

3. Software Aided Data Analysis
NOTE: Conducted to clearly determine whether weak reactions are positive or negative and to enable a semi-quantitative analysis of the
results.
1. Allow the yPADs to fully dry.
2. Scan the yPAD using a flat-bed scanner.
3. Use Imaged software to process the image.
1. "Open” scanned image to be analyzed in ImageJ located under the “File” tab on the main menu (or press “Clt+O”).
2. Invert the image selecting “Invert” located under the “Edit” tab on the main menu (or press “Clt+Shift+1”).
3. Use the “Analyze” tab on the main menu and select “Set Measurements...” to select the reported measurements analyzed.
4. Make sure that the “Mean grey intensity,” “Limit to threshold,” and “Display label” boxes are checked, and press “OK.” This sets
how the software analyzes each area selected and how it reports it.
5. Use the “Oval’ tool to draw a circle that outlines the area that you want to measure within.
6. Under the “Analyze” tab select “Measure,” (or press “Clt+M”). The software will measure the average grey intensity within the
area defined and report it in a pop-up screen that can be copied and pasted to excel for further analysis.
NOTE: For more accurate analyses, at least two technical replicates of each sample should be performed.

Representative Results

As described in this protocol, concentration of bacteria using the MMS (Figure 1) can be performed within approximately 15-20 min. The MMS in
constructed from acrylonitrile butadiene styrene (ABS) in two separate components; a lid and a cartridge both with an integrated spigot assembly
into which a cylindrical cheesecloth swab is inserted (Figure 1A). Both components are then screwed together forming the MMS (Figure 1B).
MMS-based processing is driven by a battery-powered peristaltic pump, allowing for samples to be concentrated in field settings. By coupling
MMS concentration, selective enrichments (18-24 hr), and pPADs; agricultural water can be rapidly (approximately 24 hr), easily, and cheaply
screened for important foodborne pathogens and indicator microorganisms, including E. coli, Salmonella spp., and L. monocytogenes. With

this protocol, these target bacteria can be detected at levels as low as 0.1 CFU/ml. The yPAD assays are based on the detection of bacteria-
indicative enzymes that react with colorimetric substrates (Figure 2). Assays detecting E. coli, but not E. coli O157:H7, produce a blue-green
product (Figure 2A). Similarly, the assay that detects a majority of E. coli strains produces a red-violet reaction product (Figure 2B). Assays
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detecting Salmonella spp. (Figure 2C) and L. monocytogenes (Figure 2D) produce purple-mauve and indigo colors, respectively. The test can
be interpreted by eye (qualitatively), and visual judgments are usually satisfactory for discriminating between positive and negative samples.
Alternatively, digitized images can be manipulated using ImageJ software (Figure 3A) to allow for more objective and standardized data
interpretation (Figure 3B).

Figure 1. The Modified Moore Swab (MMS) cassette. (A) The disassembled MMS. The MMS is produced in a 3-D printer from acrylonitrile
butadiene styrene (ABS) and consists of three main components: A cartridge with an incorporated spigot assembly into which a cylindrical
cheesecloth swab (folded 4-ply) is inserted and is capped with a lid having an integrated spigot assembly. (B) The assembled MMS.
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Figure 2. Bacteria-indicative colorimetric reactions. Substrates (X-Gluc, CPRG, MC, and X-InP) imbedded in the microspots of the yPADs
react with bacteria-indicative enzymes (B-glucuronidase, $-galactosidase, C8-esterase, and PI-PLC) to produce a colorimetric change. (A) A
positive X-Gluc reaction is an indication of generic E. coli, but not E. coli O157:H7; (B) a positive CPRG reaction is an indication that E. coli are
present; (C) a positive MC reaction indicates the presence of Salmonella spp.; (D) and a positive X-InP reaction indicates the presence of L.
monocytogenes.
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Figure 3. Visual and ImageJ analyses of the bacteria-indicative colorimetric yPAD tests. A shows digitized colorimetric images for each
assay with both a negative (-) and positive (+) test. Negative tests were performed using lysates of bacterial species that do not encode the
target enzymes and positive tests with lysates or enrichments of the target bacteria. (1) Unmodified scanned images. (2) Scanned images
converted to greyscale using ImagedJ software, and (3) color inverted images for subsequent interpretation of grey intensity. (4) Average grey
intensity measured using ImagedJ within each microspot of the yPAD (an example microspot is indicated by the yellow arrow and circle). B shows
the average grey intensities (determined by ImageJ) for each colorimetric uPAD positive and negative test. Please click here to view a larger
version of this figure.

This protocol describes an integrated method for detecting E. coli, Salmonella spp., and L. monocytogenes in agricultural water. Here,

MMS concentration of bacteria from large volumes (10 L) of agricultural water, is coupled with bacterial enrichment, and bacterial-indicative
colorimetric detection using yPADs. The MMS procedure can cope with high particulate content in the water samples while concentrating the
bacteria 10-fold, is robust and simple enough for field applications by minimally trained personnel, and can be performed with minimal costs. By
incorporating a bacterial enrichment step, live bacteria are detected and the sensitivity of the method is greatly enhanced. Enrichment amplifies
the target to be assayed, and when combined with selective growth media, reduces unwanted microbiota growth in samples that could contribute
to false positive results. Final detection is performed with yPADs, which provide a simple, cost effective, and easy to interpret solution to screen
for important foodborne pathogens. The entire procedure, including MMS concentration, overnight enrichment, and colorimetric detection, can be
performed within one day, and detects bacterial contamination at levels as few as 0.1 CFU/ml.

To simplify the method and reduce the possibility of contamination, the MMS is used as a container for bacterial enrichment. Adding this
enrichment to the procedure increases sensitivity, specificity, adds flexibility into the method. Although only three selective enrichments were
utilized here, improved enrichments for the bacteria could be developed. For example, we are exploring the possibility of incorporating specific
inducers into the enrichment media to enhance the production of the reporter enzymes used for colorimetric detection.

The WPADs used for pathogen detection are simple-to-use single spot arrays that cost as little as $0.002/device prior to the addition of the
colorimetric reporter substrate. Even accounting for enrichment reagents and colorimetric substrates, the cost of each test is a few cents, except
for the L. monocytogenes test which is estimated at $1.28/test due to the currently high cost of X-InP. Nonetheless, this cost compares favorably
to current detection methods for foodborne pathogenss. In their current form, the yPADs must be prepared immediately prior to testing due to
poor substrate stability. To overcome this limitation, we are testing the addition of stabilizing additives and evaluating dry storage to increase
substrate/uPAD shelf life. Additionally, we are developing multiplexed uPADs using several sample/reagent sites connected to each other by
microfluidic channels.

Despite the advantages previously detailed for the pyPAD testing, problems with assay specificity are possible: 1) The reporter enzymes are
not exclusively produced by the target bacteria, thus contaminating background microbiota may contribute to a false positive result. 2) If dark
colored particulate persists in the enrichment media, it can obscure visual and ImageJ analysis when transferred to the yPAD. 3) The current
assay cannot specifically detect E. coli O157:H7. Consequently, the method is more suited as an initial screening test providing impetus for
further testing and confirmation to be conducted. Nevertheless, many of these shortcomings are easily addressed. Incorporating a larger panel
of indicative colorimetric substrates would allow for more precise determination of the target bacterium, including E. coli O157:H7. Similarly,
additional selective enrichment procedures could minimize the contaminating microbiota in the sample. To reduce the impact of particulate in
enrichments, a coarse filter could be used prior to applying samples to the yPAD.

In conclusion, this study demonstrates that the MMS combined with enrichment and pPADs can be used to detect low levels of E. coli,

Salmonella spp. and L. monocytogenes in agricultural water. With few modifications, the procedure is portable and able to be applied in field
settings.
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